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SSL Connections

SSL/TLS is between the transport and the application layer and is protocol independent. Many IBM
products make use of GSKit to establish a secure connection. The following graphic shows an
example flow of API calls on a secure client using the GSKit APlIs.

GSK Client

gsk_environment_open () |
v
gsk_allribute_sel_buffer () I
v
gsk_altribute_set_enum () |
AJ
gsk_environment_init () I
T

socket () l
accept () == - connect () I

gsk_secure_soc_open () |

L
connects to gsk_attribute_set_numeric_value () I
gsk_secure_soc_startinit () ¥
(asynchronous handshake) — .
- gsk_secure_soc_init () |

connects to
gsk_secure_soc _init ()
(asynchronous data recelve)

connects to
gsk secure _soc read ()

(asynchronous handshaka) o
gsk_secure_soc_write ()

A

connects to
gsk secure soc startRecv () completed
(asynchronous data receive)

gsk_secure_soc write () —»  gsk_secure_soc_read () |
v

gsk_secure_soc_close () I
v

gsk_environment_close () |

close l

As you can see, the secure socket is opened after a connect() has been completed. In TCP
conversations, you would see the SSL/TLS protocol traffic after a socket has been opened and a TCP
connection successfully ESTABLISHED (as seen in netstat).



Wireshark Setup

Edit -> Preferences -> Protocols

IF3IC L T
[Pwd || [+] Reassemble fragmented IPv4 datagrams

Ip'lnl'ﬁl | al ~  oa . ' 1

TCAP || Show TCP summary in protocol tree

TCP [ ] validate the TCP checksum if possible

TCPENCAP [+] Allow subdissector to reazzemble TCP streams

TCPROS

———— [+ Analvze TCP seauence numbers

33LIK I o
55H H [+] Reassemble 551 records spanning multiple TCP segments

551 - ] i

STANAG 506 [] Reassemble SSL Application Data spanning multiple S5L records
CTAKAR SR | [T Messane Authentication Code (MAC). ionore “mac failed”

If none SSL/TLS ports are used and Wireshark does not recognise packets as SSL/TLS, you may need
to define the port to be decoded as SSL. Can add this to ‘Analyze -> Decode as’:

Field Value Type Default Current
55L Port 20000 Integer, base 10 (none)

(none)

To keep track of SSL ID and SSL ID length, you can add two columns via Edit -> Preferences ->
Columns, as follows:

Displayed Title Type Fields |
|[v] Nao. Number
] Time Time (format as specified)
[+ Delta Delta time displayed
] Source Source address
[w] Destination Destination address
] Protocol Protocol
[+ Length Packet length (bytes)
E Info Information
[w] SSL-ID Custom ssl.handshake.session_id
] SSL-1Dlen  Custom ssl.handshake.session_id_length




SSL transaction flow

Source: ww.cisco.com
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The Hello Exchange

When an SSL client and server begin to communicate, they agree on a protocol version, select
cryptographic algorithms, optionally authenticate each other, and use public key encryption
techniques to generate shared secrets. These processes are performed in the handshake protocol. In

summary, the client sends a Client Hello message to the server, which must respond with a Server
Hello message or a fatal error occurs, and the connection fails.



Interpreting a Client Hello

The Client Hello sends these attributes to the server:

e Protocol Version: The version of the SSL protocol by which the client wishes to communicate
during this session.

e Session ID: The ID of a session the client wishes to use for this connection. In the first Client
Hello of the exchange, the session ID is empty (as in the example below).

e Cipher Suite: The combinations of cryptographic algorithms supported by the client in order
of the client's preference (first choice first). Each cipher suite defines both a key exchange
algorithm and a cipher spec. The server selects a cipher suite or, if no acceptable choices are
presented, returns a handshake failure alert and closes the connection.

. : Includes a list of compression algorithms supported by the client. If
the server does not support any method sent by the client, the connection fails. The
compression method can also be null.

Secure Sockets Layer
4 TLSv1l Record Layer: Handshake Protocol: Client Hello
Content Type: Handshake (22)
|version: TLS 1.8 (@xe3e1}
Length: 133
4 Handshake Protocol: Client Hello
Handshake Type: Client Hello (1)
Length: 129
Version: TLS 1.8 (@x@38l1)
- Random: 5c38954b6d7ac9a26488T3c2c72e2cdcBd5fe77da1a34993. ..
|Session ID Length: @
Cipher Suites Length: 28
4 |\Cipher Suites (14 suites)
Cipher Suite: TLS ECDHE_RSA WITH AES 256 CBC_SHA (@xc@ld4)
Cipher Suite: TLS ECDHE_RSA WITH AES 128 CBC_SHA (@xc@l3)
Cipher Suite: TLS DHE_RSA WITH AES 256 CBC_SHA (@x@839)
Cipher Suite: TLS DHE_RSA WITH AES 128 CBC_SHA (@x@@33)
Cipher Suite: TLS_RSA_WITH_AES 256 CBC_SHA (@x@@35)
Cipher Suite: TLS RSA WITH AES 128 (BC_SHA (@x@02f)
Cipher Suite: TLS ECDHE ECDSA WITH AES 256 CBC_SHA (@xce@a)
Cipher Suite: TLS ECDHE_ECDSA WITH AES 128 CBC_SHA (@xceed)
Cipher Suite: TLS DHE_DSS WITH_AES 256 CBC_SHA (@xB@38)
Cipher Suite: TLS DHE_DS5 WITH AES 128 (BC_SHA (@x@@32)
Cipher Suite: TLS RSA WITH 3DES_EDE CBC_SHA (@x@@@a)
Cipher Suite: TLS DHE_DS5 WITH 3DES_EDE_CBC_SHA (@x@813)
Cipher Suite: TLS RSA WITH RC4 128 SHA (@x@@85)
Cipher Suite: TLS RSA WITH RC4 128 MD5 (@x@084)
Compressicn Methods Length: 1
4 Compression Methods (1 method)
Compression Method: null (@)
Extensions Length: &8
Extension: server_name (len=22)
Extension: status_request (len=5)
Extension: supported_groups (len=g)
Extension: ec_point_formats (len=2)
Extension: extended master_secret (len=8)
Extensicn: renegotiation_info (len=1)

A v v A



Interpreting a Server Hello

You can view information about the certificates presented during an SSL handshake.
In the example Server Hello below, you can see the following:

Secure Sockets Layer

Protocol Version: The chosen version of the SSL protocol that the client supports.
Session ID: This is the identity of the session that corresponds to this connection. If the
session ID sent by the client in the Client Hello is not empty, the server looks in the session
cache for a match. If a match is found and the server is willing to establish the new
connection using the specified session state, the server responds with the same value that
was supplied by the client. This indicates a resumed session and dictates that the parties
must proceed directly to the finished messages. Otherwise, this field contains a different
value that identifies the new session. The server might return an empty session_id to
indicate that the session will not be cached, and therefore cannot be resumed.
Cipher Suite: As selected by the server from the list that was sent from the client.

: As selected by the server from the list that was sent from the client.
Certificate Request: The server sends the client a list of all the certificates that are
configured on it and allows the client to select which certificate it wants to use for
authentication.

4 TLSv1.2 Record Layer: Handshake Protocol: Multiple Handshake Messages

Content Type: Handshake (22)
Version: TLS 1.2 (8x8303)

Length: 4625
4 Handshake Protocol: Server Hello

A4

b

Handshake Type: Server Hello (2)

Length: 77

Version: TLS 1.2 (@x@3@3)

Random: 2f59006123e2886b4880506a3blaee9d76301f8ec3e5639b7. ..
Session ID Length: 32

Session ID: 2a2137e1506822846ed8f4f8445c99a212c5b3dbed6277b6. . .|

Cipher Suite: TLS RSA WITH_AES 128 GCM_SHA256 (@x@@9c)

Compression Method: null (@)
Extensions Length: 5
Extension: renegotiation_info (len=1)

4 Handshake Protocol: Certificate

Handshake Type: Certificate (11)
Length: 4536
Certificates Length: 4533

Certificates (4533 bytes)

Certificate Length: 1482

Certificate: 308205c6308203aca030201020213360000301437777f99... (id-at-commonName=
Certificate Length: 1643

Certificate: 3082066730820441a20302010202137b000200027b04a471... (id-at-commonName=
Certificate Length: 1399

P Certificate: 308205733082035ba@03020102021047b3bbe82718c28f42... (id-at-commonName=

A4

-

4 Handshake Protocol: Server Hello Done

Handshake Type: Server Hello Done (14)
Length: @




New SSL connection

This is a fresh connection from a client and it will not have any reference to any previous SSL session

id, so will normally set the ‘Session ID length' field to 0. The server will establish a new session, by
performing a full SSL handshake and negotiating keys with the client. The server will assign an SSL
session ID that the client will remember. The server application would also normally have an SSL

session cache that it maintains, with a list of all SSL session ids.

Protocol  Length Info

TCP 66 22454 -+ 4808 [ACK] Seg=1 Ack=1 Win=29312 Len=8 TSval=2617138731 TSecr=16
TLSw1.2  258|Client Hello

TCP 66 4860 » 22454 [ACK] Seg=1 Ack=193 Win=38680 Len=0 TSval=168563734 TSecr=2

TLSv1.2 4?@4' Server Hello, Certificate, Server Hello [)onel

TCP 66 22454 » 4888 [A’CK] Seq=193 Ack=4639 Win=38528 Len=0 TSwval=2617138895 TSe
TLSv1.2 384|client Key Exchanﬂs, Chanﬂs Ciphe_r Spec, Encrypted Handshake Messagel
TCPR 66 4988 = 22454 [ACK] Seq=4639 Ack=511 Win=31184 Len=8 TSval=168563983 TSec
TLSv1.2 72 Change Cipher Specl

TLSv1.2 111|Encrypted Handshake Messagel

Client

._____lZEﬂﬁEﬂg_____—*

Certificate

CﬁentKeyExChange
Ch,

angeCipherSpec
Finisheq (encrypted)

ChangeCipherSPec

Fmished (encrypted)

Server

In the first Client Hello of an exchange, the session ID is empty. You can search for these packets
using the display filter “ssl.handshake.type == 1 and ssl.handshake.session_id_length == 0"

[i lsslhandshaketype == 1 and ssl.handshake.session_id_length ==0

No. Time Delta Source Destination
49752 7.205934 0.000666
49831 7.238793 ©.032859
50129 7.2384068 ©.045275
508250 7.305478 0.021410
50319 7.311263 ©8.0085785

E 51857 7.41813@ ©.106867

f 52287 7.452057 ©.833927

f 53481 7.564377 9.112320

E 53612 7.575901 ©.011524

E 53712 7.584647 ©.008746
54277 7.636559 9.0851912

154979 7.735826 0.899267

Protocol Length Info

TLSv1.2 17@ Client Hello
TLSv1.2 170 Client Hello
TLSv1.2 170 Client Hello
TLSv1.2 170 Client Hello
TLSv1.2 170 Client Hello
TLSv1 184 Client Hello
TLSv1.2 170 Client Hello
TLSv1.2 170 Client Hello
TLSv1.2 170 Client Hello
TLSv1.2 170 Client Hello
TLSv1.2 170 Client Hello
TLSv1.2 170 Client Hello

4 TLSvl1.2 Record Layer: Handshake Protocol: Client Hello

Content Type: Handshake (22)

Version: TLS 1.2 (@x@3e3)

Length: 99

4 Handshake Protocol: Client Hello

IHandshake Type: Client Hello (1)|
Length: 95
Version: TLS 1.2 (@x@3@3)

b _Random: 4dbbe3d4c242d8a@86906f5760864e8c0338681d990d3b43. ..

Session ID Length: @
Cipher Suites Length: 36
P Cipher Suites (18 suites)
Compression Methods Length: 1
P Compression Methods (1 method)
Extensions Length: 18
P Extension: supported_groups (len=8)
P Extension: ec_point_formats (len=2)




Resumed SSL connection

If the Client Hello presents a session id that the Server recognises, the session is resumed — meaning
the session reuses previously negotiated keys. A full SSL handshake is not required. This is quicker
and less ‘expensive’ than full key negotiation.

Cli
Protocol  Length Info entHE”O
[mcp 74 21812 =+ 7135 [SYN] Seq=@ Win=29;

Tcp 74 7135 + 21812 [SYN, ACK] Seq=8 A gervertello

TCP 66 21012 » 7135 [ACK] Seq=1 Ack=1 | po—

TLSvl.2  2e@|Client Hello| . ChangeCipherspP 5
TcP 66 7135 > 21012 [ACK] Seq=1 Ack=13! 5 ted) =
TLsvi.2  158[Server hello] S Finished (encryP 3

TCP 66 21812 = 7135 [ACK] Seq=135 Ack=!
TLSv1.2 ?2dhange Cipher Spec Cha .
ni
TCP 66 21812 » 7135 [ACK] Seq=135 Ack=! geCJPherSpec
TLSv1.2 72|Change Cipher Suecl anished
—2s en
TLSv1. 111|Encrypted Handshake Messagel ( Crypteco

(8]

You can search for these packets using the display filter “ssl.resume”. Wireshark expert info also
tells you the session reuses previously negotiated keys.

4 Secure Sockets Layer
4 TLSv1.2 Record Layer: Handshake Protocel: Client Helle
Content Type: Handshake (22)
Version: TLS 1.2 (@x8383)
Length: 219
4 Handshake Protocel: Client Hello
Handshake Type
Length: 215
Version: TLS 1.2 (@x@3@3)
I Random: 5c38954d85177492431f3eedfdcedccaef8ade9457ca9cha. ..
Session ID Le_ngth: 32
ISession ID: beafcefa33clicedliBsbavay39d75basb301639527198cba. .. I
Cipher Suites Length: 42
I Cipher Suites (21 suites)
Compression Methods Length: 1
I Compression Methods (1 method)

4 Secure Sockets Layer
4 TLSvl.2 Record Layer: Handshake Protocel: Server Hello

Content Type: Handshake (22)

Version: TLS 1.2 (@x@3@83)

Length: 85

4 Handshake Protecol: Server Hello

Handshake Type:
Length: 81
version: TLS 1.2 (@x8383)

I Random: d9b36e5add2a37a68dcc8dcef7e7ba41144b7abbh9987c77d. ..
Session ID length: 32
Ession ID: bGafcefa33clleedlBSbava’39d75bash301639527190:b0. .. I
Cipher Suite: TLS RSA WITH _AES 128 GCM_SHA2S6E (@x@@dc)
Compression Method: null (@)
Extensions Length: 9

I Extensicn: extended_master_secret (len=8@)

4 Secure Sockets Layer
4 TL5v1.2 Record Layer: Change Cipher Spec Protocol: Change Cipher Spec
Content Type: Change Cipher Spec (2@)
Version: TLS 1.2 (@x@383)
Length: 1

4 Change Ciphe_r spec Message
AI Expert Info (Mote/Seguence): This session reuses previcusly negotiated keys (Ses=ion resumption)] |
[This session reuses previcusly negotiated keys (Sessicn resumption)]
[Severity lewvel: Note]
[Group: Sequence]




Renegotiated SSL connection

The client thinks it is re-using an SSL session, so it will present the previously used SSL session ID to
the server. If the server does not recognise the session ID, a full SSL handshake is required in order
to negotiate keys again. As a new session must be negotiated, the Server Hello response will contain
a new SSL ID that does not match the one presented in the Client Hello. This is resource intensive
(similar to a new ssl session).

The server may not recognise the SSL id for various reasons - the server ssl cache is full, the server ssl
cache timeout has triggered, the ssl session id has been invalidated in the cache, in a cluster/load
balanced env the connection has switched to a new server, etc.

Protocol  Length Info SSL-ID

TCP 66 38544 » 443 [ACK] Seq=1 Ack=1 Win=29312 Len=0 TSval=168557763 TSecr=158786522

TLSvl1.2 282 I'Clien‘t Hello 3ce2s S265124bc405d5d1cb2d...|
TCP 1514 443 -+ 38544 [ACK] Seq=1 Ack=137 Win=131584 Len=1443 TSval=150788574 TSecr=160..

TCP 66 38544 » 443 [ACK] Seq=137 Ack=1449 Win=32128 Len=8 TSwal=16@8558282 TSecr=1567..
TCP 1514 443 » 38544 [ACK] Seq=1449 Ack=137 Win=131584 Len=1448 TSval=15@780574 TSecr=.
TCP 66 33544 » 443 [ACK] Seq=137 Ack=2897 Win=35872 Len=8 TSwval=16@8558282 TSecr=1587/
TCP 1514 443 » 38544 [ACK] Seq=2897 Ack=137 Win=131584 Len=1448 TSval=1587238574 TSecrd.

TCP 66 38544 =+ 443 [ACK] Seq=137 Ack=4345 Win=37888 Len=8 TSval=168558282 TSecr=158/.
TLSw1.2 353|Sewer Hello, Certificate, Server Hello Done eealSd?f814G335929af@ﬁabg...l
TCP 66 38544 = 443 [ACK] Seq=137 Ack=4632 Win=48832 Len=8 TSval=16@558282 TSecr=1%87..

TLSv1.2 333 Client Key Exchange
TLSv1.2 72 Change Cipher Spec
TCP 66 443 -+ 38544 [ACK] Seq=4632 Ack=418 Win=131328 Len=@ TSval=158780691 TSecf=160..
TLSvl.2 111 Encrypted Handshake Message

TLSv1.2 117 Change Cipher Spec, Encrypted Handshake Message

4 Handshake Protocol: Client Hello

Handshake Typei Client Hello (1)'
Length: 127
Versiecn: TLS 1.2 (@x8383)

I Random: 51e7b8l8d4efeb65e2ebbec2aftbebdlab5238d8758468Fc3@. ..
Sessien ID Length: 32
I'Session ID: 3ce258265124bc486dS5dlcb2dd7dlecff29c686dBafdac27. .. |
Cipher Suites Length: 36

I Cipher Suites (18 suites)

4 Handshake Protocol: Serwver Hello

Handshake Type:l Server Hello (2) I
Length: 77
Version: TLS 1.2 (@x@3@3)

' Random: fc4d44c46d99abedbfe47c2061c636T1d2810eTbbeedsd4s. ..
Session ID Length: 32
| session ID: eeal5d7f8148336929af@6abid2basffecol44686T97ef2b. .. |
Cipher Suite: TLS_RSA_WITH_AES 128 GCM _SHA256 (@x@@dc)




Example delay from establishing TCP connection to SSL handshake

0.82 second delay from establishing connection to sending ssl handshake

(W Ttcp stream eq 3475 B3 -] Expression
No. Time Delta Source Destination Protocol  Length Info

82442 11.345329 ©8.822968 TLSvi.1 202 Client Hello
|1 82515 11.3483a2 ©.003013 . TLSv1.1 227 Server Hello, Change Cipher Spec, Encrypted Handshake Message

82516 11.348355 0.000013 TCcP 66 38054 + 443 [ACK] Seq=137 Ack=162 Wi Len=@ TSval TSec 138

82602 11.362448 ©0.014093 TLsvi.1 72 Change Cipher Spec

84436 11.537555 0.175107 TLSv1.1 135 Encrypted Handshake Message

84466 11.540515 2.002960 TP 66 443 -+ 38054 [ACK] Seq=162 Ack=212 Win=514 Len=@ TSval=150663157 TSecr=16@562882

0.45 second delay from establishing connection to sending ssl handshake

No. ~ Time Delta Source Destination Protocol  Length Info

64488 13:08:30.541403 TCP 66 37426 » 443 [ACK] Seq=1 Ack=1 Win=29312 Len=@ TSval=16560356 TSecr=150662877
0.445540 TLSv1.1 202 Client Hello
B 3 TISVi.1 227 Server Hello, Change Clpher Spec, Encrypted Handshake Message
0.000014 TP 66 37426 » 443 [ACK] Seq=137 Ack=162 Len=@ Tsval TSec)
66375 13:08:31.012265 ©0.018631 | TLSVI.1 72 Change Cipher Spec
67376 13:08:31.214608 ©.202343 | TP 66 443 + 37426 [ACK] Seq=162 Ack=143 Win=131584 Len=0 TSval=150662954 TSecr=160560827
67523 13:08:31.233115 0.018507 . TLSVI.1 135 Encrypted Handshake Message
67951 13:08:31.276130 0.043015 : TLSvi.1 1063 Application Data
67963 13:08:31.276956 ©.000826 - TCP 66 443 -+ 37426 [ACK] Seq=162 Ack=1209 Win=130568 Len= TSval=150662960 TSecr=160561047
68245 13:08:31.303681 0.026725 : TLSvi.1 919 Application Data
68667 13:08:31.343163 0.039482 TP 66 37426 + 443 [ACK] Seq=1209 Ack=1815 Win=32000 Len=0 TSval=160561158 TSecr=150662963

- 71460 13:08:31.597830 ©.027266 Tce 66 443 + 37426 [ACK] Seq=1016 Ack=1210 Win=130560 Len=0 TSval=150662992 TSecr=160561385

This could indicate that there is a performance issue on the server acting as the SSL client. Key
negotiation is resource expensive, so check to see if sessions are not being resumed where you
would expect them to be (i.e. there are many unnecessary renegotiated SSL handshakes).



